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5
MANAGING DOCUMENTS USING

WORD PROCESSOR

5.1  LET’S START

A Word Processor is a software package that helps you to create and edit
documents. Creating a document involves typing it into the memory of the
computer and saving it. Editing a document means correcting the spellings
and grammatical mistakes, if any, committed during the course of typing. It
also involves deleting or replacing words, sentences or paragraphs.

In the previous lesson you have learnt about development of typewriting
speed and accuracy, rules of spacing in punctuation marks, identification and
rectification of typewriting errors. In this lesson, you will study about MS-
Word and its various features for formatting, creating bulleted numbered list
and utility of Mail Merge.

5.2 OBJECTIVES

At the end of this lesson, you will be able to:

 appreciate the need for a word processor

 start Ms-Word

 identify the components of document window

 format documents

 preview and print documents

 use Keyboard Shortcuts

 create Bullets & Numbered list

 perform  spell check and grammar check

 create & format Tables

 use  Mail Merge feature
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5.3 LEARNING COMPETENCIES

After studying this lesson you will be able to attain the following competen-
cies:

 Recognise the word processor screen & its tool

 Do formatting of documents i.e. Bold , Italic, Underline, Bullets &  Num-
bering

 Run spell check utility to create an error free document

 Create simple &  complex tables

 Perform the Mail Merge , create labels and envelopes.

5.4  LET’S LEARN:  MS-WORD

A word processor is a software package that helps you to create and edit
documents.  Creating a document involves typing it into the memory of the
computer and saving it. Editing a document means correcting the spelling
and grammatical mistakes, if any, and deleting or moving words, sentences
or paragraphs.

There are many software packages for word processing (WordStar,
WordPerfect, Microsoft Word, Open Document, etc) Microsoft Word is one
of them.  It is a part of the package called MS-OFFICE. There are so many
versions of MS-Office such as Office95, Office97, Office97 powered by 98,
Office 2000, Office XP, Office2003, Office2007 and Office2010. In this les-
son we will use Office2007 i.e. Microsoft-Word 2007.

5.4.1 Features of MS-Word
Important features of MS-Word are listed below:

i. By using Word, you can create the documents, edit them later, by adding
more text, modifying the existing text and deleting/moving some part of
it.

ii. Size of the margins can be changed.
iii. Font size and type of fonts can be changed.
iv. Automatic Page numbering including Header & Footer can be added.
v. Spellings and Grammar check can be undertaken automatically in the

entire document.
vi. Tables and Text boxes can be inserted.
vii. Graphics can be created or inserted from Clip Art Gallery. Downloaded

pictures, graphics & text can also be inserted in a word document.

viii. Word also provides the mail-merge facility.
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Do  You  Know?

MS Word is one of the component of a bigger software package called
Microsoft Office. Microsoft Office is an office suite created by Microsoft
Corporation and consists of the following :

1. Microsoft Office Access
2. Microsoft Office Excel
3. Microsoft Office InfoPath
4. Microsoft Office Outlook
5. Microsoft Office PowerPoint
6. Microsoft Office Publisher
7. Microsoft Office Word
8. Microsoft Office Tools

5.4.2  Starting MS-Word

The steps to activate Word are:

 Click on the Start button on taskbar.

 Select the Programs option from the Start Menu.

 Click on the Microsoft Office  - > Microsoft Word 2007 (or it can be
directly available under start menu) Option (fig-5.1)

Fig 5.1 : Opening MS- Word 2007

This invokes MS-Word and displays a Document Window.
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5.5 DOCUMENT WINDOW

Let us discuss the important components of the screen which are given
below:

Fig 5.2 : MS Word Screen Layout

(a) Title Bar

The title bar displays the name of the currently active word document
like it is displaying the default name of the document (file) i.e., docu-
ment1. Like other WINDOWS applications, it can be used to alter the
size and location of the word window. It also contains the Control Menu
Icon, the Maximize button, the Minimize button, the Restore and the
Close Buttons.

(b) Ribbon (Toolbar)

Word has a number of tool bars that help you perform task faster and
with great ease. This is the default Ribbon under the “Home” tab.
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Fig 5.3 : Home Ribbon Toolbar

(c) Ruler Bar

The Ruler Bar allows you to format the Vertical and Horizontal align-
ment of text in a document.

(d) Status Bar

The Status Bar displays information about the currently active docu-
ment. This includes the page number that you are working, the column
and line number of the cursor position and so on.

(e) Scroll Bar

The Scroll Bar helps you scroll the content or body of document. You
can do so by moving the elevator button along the scroll bar or by click-
ing on the buttons with the arrow marked on them to move up, down,
left and right of a page.

(f) Workspace

The Workspace is the area in the document window where you enter/
type the text, add the image, graphics etc. of your document.

(g) Main Tab (Main Menu)

The Word main tab is displayed at the top of the screen below title bar.

Fig 5.4 : Main Tab(Home)

If you click on any of the tab key, it will display the respective Ribbon
(Toolbar).The default tab is ‘Home’ tab (as shown in Ribbon topic), but if
you click on the ‘Insert’ tab, the screen will be changed which is given be-
low:

Fig 5.5 : Insert Tab (Ribbon/Tool bar)
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INTEXT QUESTIONS 5.1

1. State True or False :
a. The title bar displays the name of the currently active word docu-

ment.
b. Two of the most commonly tool bars are the formatting tool bar

and the standard tool bar.
c. The tool bar allows you to format the vertical alignment of text.
d. The scroll bar helps you to scroll the content or body of document.
e. The workspace is the area in the document window where you

enter/type the text.
f. Word processor is Software Package that enables you to create,

edit, print and save a document.

5.6 FORMATTING TEXT
The formatting refers to the changes you make in your document’s appear-
ance. Formatting is an important part of documentation. Use the Font
Dialog Box Launcher as given below, which can change the font face, size,
color, etc.

Fig  5.7 Font Dialog Box
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5.6.1 Changing the font style (font face)

Font refers to the manner or style in which text is displayed in the document.
Different fonts contain different collection of character and symbols.  Word
offers many ways to change fonts and font styles.

Steps to change the Font Styles are:

 Select the text of font which has to be changed.

 Click on down-arrow to the right to the font list box in  the Formatting
Dialog Box (refer to the figure given below)

Fig  5.8 Font styles

 Select a font from the list.

 Use one or more options from the dialog box to do the following:
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Button Name Buttons Purpose Sample Output

Bold To make the selected Text Bold National Open School

Italic To make the selected Text Italic National Open School

Underline To underline the selected text National Open School

Strikethrough To draw a line through the middle National Open School
of the selected text.

Subscript To create small letters below the H20
text baseline.

Super Script To create small letters above the X2Y
text baseline

Table 5.1 Format text

5.6.2 Changing the Font Size

Font size is measured in points. Points and picas are used for measuring
spacing, line thickness, and so on.

Steps to change the Font Size :

 Select the text and the font size of which has to be changed.

 Click on the down-arrow to the right of the Font Size list box. (refer fig)
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A list of available font’s sizes is available.

Fig: 5.9 Font size

 Select a font size from the list.

5.7 CUT, COPY PASTE, UNDO, REDO, ALIGNMENT

The cut, copy and paste commands can be used to copy or move any text
from one place to another place. Now these commands are available on the
Home tab as the Clipboard option. (Refer fig)

Fig : 5.10 Clipboard Group (Home Tab)

 Both cut and copy commands put the selected text in a temporary memory
called Clipboard.

 The cut command moves the selection to the clipboard.

 The copy command copies the selection to the Clipboard.

 The paste command copies the content of clipboard at the insertion point.

 A combination of cut and paste results in a move operation.

 A combination of copy and paste results in a copy operation.

Steps to copy or cut the text to another part of the same document or in a
different documents are:
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1. Select the text to be copied or cut.

2. Right-click on the highlighted text.

A Shortcut menu appears near the highlighted text (refer fig)

Fig: 5.11 Pop up Menu (on Right Click)

3. Select the Cut or Copy option from the shortcut menu.

4. Position the cursor at the location where the text is to be pasted.

5. Select the paste option from the shortcut menu. Whether you have cho-
sen cut or copy lastly you have to Paste the content.

Alternatively, select the Cut           or Copy Option           from the clip board

and then use paste option.

UNDO

The Undo command quickly reverses the changes in editing, formatting and
the other action:

Click on undo button i.e.               From the Quick Access Toolbar available

on the title bar’s extreme left.

Alternatively, Press Ctrl + Z.

REDO

The Redo command repeats the action, click on Redo Button i.e.              from
the Quick Access toolbar available on the title bar’s extreme left.
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Alternatively, press Ctrl+Y.

Aligning Text

Alignment is a way of organizing the text. It refers to the position of the text
relative to the margins. Word has the four types of alignments i.e. left-align,
right-align, center-align and justify. This can be done by clicking on the given
icons on the Home Menu Option of the paragraph.

Fig: 5.12 Alignment text ( Paragraph Group- Home tab)

By default, Word uses left alignment.

Left Align:  For adjusting the left margin.

Right Align: For adjusting the right margin.

Center- Align: The center option is normally used to centralize the heading
and text.

Justified Text: This feature aligns a paragraph with both the left and the
right margins. Inter-word spacing is adjusted so that each line of text ends at
the right margin. To justify a line of text, position the cursor on that line and
click on the Justify button on the toolbar.

5.8 TYPES OF PRINTERS

One of the output devices is printer, which is used to take the hard copy of
the document or image you require to print.

The different kinds of printers are:

 Dot Matrix Printer (DMP)

It is the most versatile printer which uses hammers of pin size, inte-
grated head assembly contains nine or twenty four pins. The per page
cost is very low, but the speed is very slow as compared to the other
printers.

 Inkjet Printers

These printers use a small compact device, which controls the flow of
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water base ink through microscopic nozzles, known as cartridge. With
the help of the cartridge, ink is sprayed on the paper. The per page cost
is very high because of the high cost of cartridge. The speed is better
than the DMP.

 Laser Printers
This is the most expensive printer and laser beams are used to print. In
this printer, printing is done through the powder based ink which is
heated (by heater) and thus, we get the text or image on the paper. The
per page cost is little lower than the Inkjet Printer. The speed of Laser
Printer is better than the Inkjet Printer.

5.8.1 Previewing a Document

Previewing a document means viewing a screen representation of one or
more pages of the document before printing them.

 Steps to print preview a document are:

1. Open the document to be previewed.

2. Select the Print Preview Option, from the Office button         i.e. extreme
left of the title bar.

Fig. 5.13 : Opening print preview
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The Print Preview dialog box is displayed (refer fig below)

At the top of the Print Preview Window is a toolbar with buttons that
perform the actions listed below:

Toolbar Button Function

Prints the displayed document.

Displays the properties of the document.

Through this we can set page setup like margins,
orientation (i.e. Landscape or Portrait), size

Fig. 5.14 : Print preview dialog box
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It is used to zoom the page size.

Displays the actual size window.

Displays the multiple pages option.

Shrinks the type size of the displayed document
to make it fit on one less page.

To turn the vertical and horizontal ruler on and
off.

To change the pages.

To close the Print Preview.

5.8.2 Printing a Document

The steps to print a document are:

3. Select the Print Option, from the
Office button  i.e. extreme left of
the title bar.

Table 5.2 : Toolbar options in Print Preview Window
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The print dialog box is displayed

1. Select the printer on which you want to print the document in the Name
text box.

2. Select one or more options from the given table:

Option Function

All Print all the pages of the document.

Current Page Print only the current page (i.e. on which cursor is
lying) of the document.

Pages Print the specified range of the pages.

Selection This option is used only when you have selected some
portion of the document, this is used to print only
the selected portion.

Number of copies For printing the number of copies of the document.

3. Click on the Properties Button.

Fig. 5.15 : Print dialog box

Table 5.3 : Options available in Print dialog box
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The printer Properties dialog box is displayed

4. Select the different tabs to do the print properties.

5. Change the paper sizes and orientation.

6. Click on the OK button to close the properties dialog box.

7. Click on the OK button to send copies to the printer.

INTEXT QUESTIONS 5.2

Fill in the blanks

a) ______ is the most expensive printer in which laser beams are used to
print.

b) ________ feature aligns a paragraph with both the left and the right
margins.

c) _____ button make the selected Text Italic.

d) ______ create small letters above the text baseline.

e) The speed of ________ is very slow as compared to the other printers.

f) The keyboard shortcut of Redo is _______.

g) Word offers many ways to change fonts and __________

Fig. 5.16 : Printer Properties dialog box
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5.9 BULLETS & NUMBERING

With Word you can quickly create Bulleted and Numbered lists to make a
document easier to read and understand.  To create the Bullets and Number-
ing list, click on the buttons given on the Home menu option of the para-
graph toolbar.

         Bullets            Numbering         Multilevel List

The steps to add bullets or numbers or multilevel list are:

1. Select an existing list or type in a new list.

2. Click on the button, the given figure is displayed and you can choose
the appropriate Bullet or Number.

5.10 SPELL CHECK & DICTIONARY

When a document is typed, no matter how careful the user is, mistakes are
likely to be committed. Most of these are spelling errors. Word ensures that
every document is free of spelling, and flags unfamiliar words with a red
wavy underline and the grammar mistakes with green wavy underline.

Fig. 5.17 : Bullets and Numbering

Fig. 5.18 : Bullets and Numbering Library
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Using The Spell Check Utility
The spelling and grammar option is available under the “Review” menu group.
The steps to spell-check a document are:
1. Select the section of the document to be spell-checked.

If nothing is selected, Word checks the entire document.
2. Select the spelling and grammar option from the “Review” menu op-

tion.

The spelling dialog box is displayed (refer fig). The unfamiliar words
are displayed in the ‘Not in Dictionary text box’ and correct the spell-
ing appears in the ‘Suggestions to list box’.

3. Click on any one of the buttons explained below:

Button Function

Change To replace the mis-spelt word

Change All To replace all the occurrences of the mis-spelt words
in the document.

Ignore Once To ignore the mis-spelt word

Fig. 5.19 : Review menu

Fig. 5.20 : Spelling & Grammar dialog box
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Ignore All To ignore the words in the whole document.

Add to Dictionary To add the word displayed in the ‘Not in the Dic-
tionary text box’ to the Dictionary, so that no next
error will be encountered with similar word.

Undo Edit To reverse the last change.

Cancel To discontinue the spell check.

A dialog box is displayed when the spell-check reaches the end of the docu-
ment or selection (refer fig)

5.11  TABLE

Word provides many ways to create and format tabular information. Word’s
table feature provides excellent means to tabulate the information and to sort
it.

A table helps you to organize and present complex columnar information.

A table is a grid of columns and rows. The intersection of a column and a row
is a rectangular or square box called a cell.

5.11.1  Inserting a Table

The steps to insert table in a document are:

1. Place the insertion point at the location where you want the table to
appear.

2. Click on the Table option from the ‘Insert’ menu option.

Fig. 5.21 : Spell check completion
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3. Click the Tables Button on the Tables Group.  You can create a table in
the following four ways:

a) Highlight the number of row and columns

b) Click Insert Table and enter the number of rows and columns. (re-
fer fig)

c) Click the Draw Table, create your table by clicking and entering
the rows and columns

d) Click Quick Table and choose a table.

Fig. 5.22 : Table menu options

Fig. 5.23 : Insert table options
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4. Table will be displayed on the screen. Place the cursor in the cell where
you wish to enter the information.  Enter the data.

5.11.2 Modify the Table Structure and Format a Table

To modify the structure of a table:

 Click the Table and notice that you have two new tabs on the
Ribbon:  Design and Layout.  These pertain to the Table design and lay-
out.

On the Design Tab, you can choose:

 Table Style Options

 Table Styles

 Draw Borders

To format a table, click the table and then click the Layout Tab on the Rib-
bon.  This Layout tab allows you to:

 View Gridlines and Properties (from the Table Group)

 Insert Rows and Columns (from the Rows & Columns Group)

 Delete the Table, Rows and/or Columns (from the Rows & Columns
Group)

 Merge or Split Cells (from the Merge Group)

 Increase or Decrease cell size (Cell Size Group)

 Align text within the cells and change text directions (Alignment Group)

Fig. 5.24 : Table layout
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Popup Menu (will appear when you place the cursor on table and press right
click) can also help to do the various settings to the Table (refer fig)

Table properties dialog box is used to change the various settings of Table
using tab keys for the individual rows, columns or cells. It can be used for
alignment, size and preferred width.

Fig. 5.25 : Popup Menu

Fig. 5.26 : Table properties dialog box



80 :: e-Typewriting

5.12 MAIL MERGE

Mail merge can be used for creating many documents at once that contain
identical formatting, layout, text, graphics, etc., and where only certain por-
tions of each document varies. Mail merge is also used for generating mail-
ing labels, envelopes, address lists, personalized training handouts, etc. as
well as hard copy mail shots, it can be used to generate multiple e-mails and
electronic faxes.

You can use mail merge when you want to create a set of documents that are
essentially the same but where each document contains unique elements. For
example, in a letter that announces a new product, your company logo and
the text about the product will appear in each letter, and the address and
greeting line will be different in each letter.

A set of labels or envelopes: The return address is the same on all the labels
or envelopes, but the destination address is unique on each one.

Steps To Perform Mail Merge

1. Click on the Mailings Menu Option, the toolbar will change. (ref fig)

2. Selecting Recipients for Mail Merge Letters

“Click Select Recipients on the Mailings ribbon to add recipients to the
mailing.

You can opt to create a new database of recipients. You can also opt to use an
existing list or Outlook contacts.

Fig. 5.27 : Mailings Menu
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3. Adding Recipients to Your Mail Merge Database

In the New Address List Box, begin entering your contacts.

You can use the Tab key to move between fields. Each set of fields is referred
to as an entry. To add additional recipients, click the New Entry button. To
delete an entry, select it and click Delete Entry. Click Yes to confirm the
deletion. (refer below mentioned’ fig. 5.29)

4.  Adding and Deleting Mail Merge Fields

Fig. 5.28 : Typing New Address list

Fig. 5.29 : Delete dialog box

Fig. 5.30 : Customize address list
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You may wish to delete or add field’s types to your mail merge document.

You can do that easily. Just click the Customize Columns button. The
Customize Columns dialog box opens. Then, click Add, Delete or Rename
to alter the field types. You can also use the Move Up and Move Down
buttons to rearrange the order of the fields.

After deleting the column the New Address List Dialog Box will look like
this:

When you’re done, click OK.

Once you’ve added all your recipients, click OK on the New Address List
dialog box. Name the data source and click Save.

5. Inserting a Merge Field in Your Document

To insert a field into your document, click Insert Merge Field on the Mailings
ribbon. Select the field you would like to insert. The field name appears
where you have the cursor located in your document.

You can edit and format the text surrounding the field. Formats applied to
the field will carryover to your finished document. You can continue to add
fields to your document.

Fig. 5.31 : New Address list dialog box
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6. Previewing Your Mail Merge Letters

Before you print your letters, you should preview them to check for errors. In
particular, pay attention to spacing and punctuation surrounding the fields.
You will also want to make sure you have inserted the correct fields in the
correct places.

To preview the letters, click Preview Results on the Mailings ribbon. Use the
arrows to navigate through the letters.

7. Correcting Errors in Mail Merge Fields

You may notice an error in the data for one of your documents. You cannot
alter this data in the merge document. Instead, you’ll need to fix it in the data
source.

To do this, click Edit Recipient List on the Mailings ribbon. In the box that
opens, you can alter the data for any of your recipients. You can also limit the
recipients. Simply uncheck the box next to recipients’ names to omit them
from the merge operation. When you’re done, click OK.
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8. Finalizing Your Mail Merge Documents

After you’ve reviewed your documents, you’re ready to finalize them by
completing the merge. Click the Finish & Merge button on the Mailings
ribbon.

You can opt to edit individual documents, print the documents, or email
them. If you opt to print or email your documents, you’ll be prompted to
enter a range. You can opt to print all, one, or a set of contiguous letters.
Word will walk you through the process for each.

Alternatively, you can also do the mail merge by step by step method which
can be selected from by clicking on the icon Start Mail Merge. This will
open the Mail Merge menu. Select Step by Step Mail Merge Wizard.

This option will take to the previous version mail merge steps.

INTEXT QUESTIONS 5.3

1. State True or False
a. Using View tab you can perform editing functions such as cut, copy,

paste, find and replace etc.
b. A table helps you to organize and present complex columnar infor-

mation.
c. Using Insert tab you can insert various objects such as page num-

bers, footnotes, picture frames etc.
d. Using Mailings you can access to various utilities of word such

spell check, macros and mail merge etc.
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5.13  KEYBOARD SHORTCUTS


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5.14  LET’S SUM UP

                        To               Do this

Create a new file Choose file   new or choose the new icon on
standard toolbar Switch from one file to another
Choose the file n  ame from the window menu

Give a file a permanent file name File   save as
Save a file File   save
Save a file using different file type File  save as. in save as dialog box choose a file

type from the save file as type box.
Create a backup file Choose tools; then select always cerate backup copy

option on the save tab
Print a document Choose file  Print
Preview a document Choose file  Print  preview
Change page size or orientation Choose file  page setup  paper size
insert a page or section break click   Insert  Break
Add page numbers click Insert  Page numbers
Create Header & Footer click  View  Header & Footer

Change Margins choose file  page setup  margins

Employability Skills : Practical Work Task

1. Create a Resume of your own in MS-Word

2. Create your class time table

3. Using mail merge create an invitation letter for ten of your colleagues invit-
ing them for a birthday bash.

5.15 TERMINAL QUESTIONS

1. What is the use of Mail Merge? Explain the steps to create Mail Merge?

2. Write the steps to add bullets or numbers or multilevel list?

3. How many types of printers are there? Explain each one of them.

4. What is the difference between Undo and Redo?

5. How will you distinguish between Cut Paste and Copy Paste?

6. Write a short note on Formatting Text?

7. What are the important features of Ms-Word? Write the steps to open
MS-Word.

8. How many types of toolbar are there? Explain any two of them.
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5.16 ANSWERS TO INTEXT QUESTIONS

 5.1

a) True

b) True

c) False

d) False

e) True

f) True

g) False

 5.2

a) Laser

b) Justify

c) ‘I’

d) Superscript

e) Dot Matrix Printer

f) Ctrl + y

g) Font size

 5.3

a) False

b) True

c) Ture

d) False




